Layers

What Layers Are All About

Layers were introduced in Photoshop 3 (1994) and are perhaps the program’s most valuable tools. They serve a myriad of purposes. In this document I’ll outline their functionality. I refer to layers extensively throughout the book since they are inevitably where all aspects of an image are created.

A Photoshop document can have as many layers present in the document as memory will permit. Each of the layers contains parts of the overall image. These layers can be manipulated individually in as many ways as you desire without affecting the rest of the image.
Multiple Undos

Let’s start by looking at some of the not so obvious uses of layers. I tend to see layers as a form of multiple undos. Yes, Photoshop does support multiple undos in the form of History. However, History is volatile. Once a document is closed, History is gone. Even if you haven’t closed the document, by default History only saves the last 20 states. In my type of work, that’s a very small number. By placing every element of an image in its own layer, you have the ability to alter or discard the contents of that layer at any time. Layers don’t replace History, and History certainly doesn’t replace Layers.

Take for instance the client who wants to run last year’s ad with a slight modification to the image. Figure 1 serves as an example of this situation. The client wants to run the same image but wants the neon and the sides of the letter shapes housing the neon that are currently green to appear in red. In Figure 2 the layer containing the neon tubes has been selected and colorized using the Hue/Saturation command. In Figure 3 the same process has been applied to the sides of the letters.

It is important in this situation to complain to your client about all the work that has to be done. Provided the client has not taken a Photoshop class, you have a good case. After spending the five minutes making the adjustments, watch a little TV or go for a walk. Then just before meeting the client, splash a little water on your forehead to look like perspiration. I’m just joking, though I am sure many of you will do it.
Personal Stock Library

In my type of work, repurposing (also known politely as “reusing” and somewhat less politely as “stealing stuff”) is another major advantage of layers. If all the elements of an image are in their own layer, those elements can then be used in other images. Figure 4 shows a cover that I did for a magazine. Note the lightbulbs in the marquee. Also note the rug on the floor by the door. The bulbs came from my painting “Oakland” shown in Figure 5. The rug came from another painting, “Oyster Bar,” shown in Figure 6.

In a sense, layers are like having your personal stock image library of elements that can be used over and over again. In most cases a change in color or the removal of a shadow or dirt will be enough to modify the object and have it fit into the new environment. Shadows and dirt would be in their own layer so the process of altering them requires nothing more than a simple click.

Figure 4 The cover of a magazine.

Figure 5 The bulbs were borrowed from this unrelated painting.

Figure 6 The rug from this second unrelated painting was used for the magazine cover.
Some repurposing of existing layers happens within the “Damen” painting. For instance, the two additional train cars are copies of the first car (Figure 7). Since every part of the car was in a separate layer, it was easy to make them look different. The reflections in the windows were replaced. The dirt on the exterior was altered. The numbers on the cars were changed. Finally, the cars were rotated to make the angles differ as the train rambles down the track.

The intricate brick texture on the side of the building in the center of the image (Figure 8) was repurposed as well. The colors of the grout and bricks were changed and rescaled to represent the brick façade of one of the buildings in the distance (Figure 9).

Figure 7 The additional train cars are based on the original with slight modifications to make them look different.

Figure 8 The brick wall on the side of the orange building.

Figure 9 The brick wall on this building was made from the brick texture of the orange building.
Working with Layers

Simply stated, layers allow bitmapped images to exist on discrete planes, each individually editable at any time. Each layer can be edited and adjusted separately from everything else in the document.

While adding layers to a document increases the overall size of the document, only the active pixels in a layer are taken into account—the surrounding transparent areas around the active pixels don’t take up memory.

Basic Layer Hierarchy

The priority, or position of layers, can be changed at any time in the foreground/background space by repositioning them in the Layers panel. Layers can be reprioritized. The hierarchy is top down: The Background layer is at the bottom of the layer list and is also the farthest object in the background. Layers on top of the Background layer appear to be in front. An object in a layer that sits above another layer in the Layers panel will be seen in front. Figure 10 shows a layer containing a yellow circle. It sits above a layer that contains some text. If you move the layer containing the yellow circle so that it is below the layer with the text, the yellow circle will appear behind the text (Figure 11).

With the simplest settings—100% Opacity, Normal mode, no Blend If options applied, no layer mask—the uppermost layer completely covers whatever may be underneath it. But when any of these settings are changed, the layers affect each other and create some combination of the top and underlying layer. Infinite permutations are possible.
Creating Layers

When you paste the contents of the clipboard into an image, a new layer is created automatically for the pasted material. If the image is smaller than the layer into which it is pasted, the remaining area of the new layer will be transparent (layer transparency is covered later in this document).

Using the Move Tool, you can move the contents of the layer anywhere you want.

You can duplicate an existing layer by dragging it over the Make new layer icon at the bottom of the panel (Figure 12). Clicking the Make new layer icon creates a new, blank layer where you can create new elements in the image.

Multiple layers can be modified at the same time. To select multiple layers, you simply click on them in the Layers panel while pressing the Shift key, as shown in Figure 13.

Figure 12 The Make new layer icon.

Figure 13 Multiple layers can be selected by pressing the Shift key.
Noncontiguous layers (Figure 14) can be selected by pressing the Command (Ctrl) key. The modifications are somewhat limited to movements and transformations—like scaling and rotating. Complex transformations like Warp and filters cannot be applied to multiple layers at once.

You can rename layers by double-clicking on a layer’s name in the panel.

Turning the “eye” icon off for a layer makes it invisible (Figure 15).

Elements of an image can be separated from the overall image so that they can be altered in any way while the original image remains untouched. They can be scaled, colorized, or filtered separately from the rest of the image. This can be done by selecting the area to be modified with any of the selection tools and then choosing Layer > New. The selected area is sent to a separate layer where changes will be applied to that layer. Having elements in their own layer is especially handy when trying to create a collage of multiple elements. It is crucial to be able to reposition elements to achieve a balanced composition without leaving holes in the background every time you move an element.

Figure 14 Noncontiguous layers can be selected by pressing the Command (Ctrl) key.

Figure 15 Layers can be hidden by turning off the “eye” icon.
When you select a portion of an image to be sent to a layer, there are two methods you can use. The first is New Layer Via Copy (Figure 16), which sends a copy of the selected area to a new layer while leaving the original layer untouched.

The second method is New Layer Via Cut (Figure 17), which cuts the selected area out of the layer from which it is selected and sends it to a new layer. In the original layer a hole appears where the selection was made. If the selection was made from the Background layer, the hole will be the color currently selected for the Background color in the tools panel. If the selection was made to an existing layer, then what remains after the cut is a transparent area the shape of the selection.

Big Data

Photoshop 4.0 introduced a new technology to enhance the way layers work. It was called Big Data, which means that Photoshop retains image data that lies beyond the edges of the canvas. Layers that have been partially moved or scaled beyond the image boundary or that have been placed or pasted from large documents into smaller documents, won’t be visible if the file is printed as is, but they won’t be cropped out of the file either. The key to Big Data being useful is that it stores this excess, off-canvas data in the image file, keeping all image data (visible or not) between Photoshop sessions. To get rid of excess Big Data you don’t need (it can really increase the size of your file), use the Select All command (Select > Select All) and the Crop command (Image > Crop).
The Layers Panel

The Layers panel is the control center for all your layer operations. Like all other panels, you can dock the Layers panel with the other panels, as shown in Figure 18. The panel can also be viewed as a stand-alone panel that floats wherever it is placed.

As with previous versions of Photoshop, pressing the Tab key will hide all the panels. CS3 has a new feature: When you press Shift-Tab, the panels that appear on the upper right will be hidden. Placing the cursor over the area where the dock for the panels exists will make them appear temporarily. When you’re done with the panels, they will disappear again.

Figure 19 shows the Layers panel and all of its components. Figure 20 shows the drop-down menu that is part of the Layers panel when you click on the menu icon in the upper-right corner of the panel.

Figure 18 The Layers panel in the panel dock.

Figure 19 The Layers panel.

Figure 20 The Layers panel drop-down menu.
Modes

Let’s study the Layers panel in detail (Figure 21). The item at the top is the Mode. Normal happens to be the default mode, which is what you see as the first item in the Mode menu. Mode determines how one layer or group affects the layers underneath it. All of these modes can be found in many of the other Photoshop functions. The Brush Tool, Fill command, and many others utilize modes to create an effect.

Normal

The Normal mode has no effect on other layers other than blocking them out where the contents of the layer exist. This mode is used for straight compositing. Opacity will allow the layers beneath to be visible based on the level of opacity.

Dissolve

Dissolve breaks up the edges of the layer. The level of feather that is applied to the edge determines the amount of dissolve. Figure 22 shows an apple in a layer over a gradient background. Figure 22a zooms in to show the edge of the apple.

In Figure 22b, Dissolve has been chosen as the mode for the layer. Note the slight jagginess to the edge. In Figure 22c the edge has been selected with a border (Select > Modify > Border) and heavily blurred with the Gaussian Blur filter. Figure 22d shows the result of Dissolve on the blurred edge. The softer the edge, the stronger the effect.

If you reduce the Opacity for the layer, the dissolve will be visible throughout the entire layer, as shown in Figure 22e. The lower the Opacity setting, the more pixels disappear.
To best understand how the remaining Modes affect an image, I’ll provide you with four examples for each Mode. These examples will be based on two RGB and two grayscale images.

The first RGB image (a) will be affected by a layer containing multiple colors plus a black and white oval, as shown in Figure 23.

The second RGB image (b) will then be affected by a layer that contains a gradient from black to white (Figure 24).

The third image (c) set to grayscale will be affected by a layer with a color gradient (Figure 25).

The fourth image (d) set to grayscale will be affected by a layer that contains a gradient from black to white (Figure 26).

In a few instances there is no obvious effect. In others, the effect is quite dramatic.

**NOTE:** Keep in mind that some of these modes have a completely different effect when applied to a CMYK file. If you have added many blend modes you may find that when you convert to CMYK the effects created by the modes can change dramatically. It is recommended that you first flatten the file before you make the conversion.
The Darkening Modes (Including Multiply and the Burns)

Darken

Darken, the first of five modes that either partially or totally darken the final product, looks at the values of overlapping pixels and outputs whichever is darker. Any channel in the top layer that is darker than the corresponding channel in the bottom layer takes precedence over what’s underneath. If the channel is the same or lighter than the channel underneath, the top channel is ignored and the underlying material remains visible. Darken will have no effect on a duplicate of itself.

It does not solve the problem of overexposed light areas like Multiply can. It does come in handy for getting rid of that little blown-out area on your uncle’s head in the family picture. By choosing a nice flesh tone from some other part of his head, you can use the Paintbrush in Darken mode to paint that hot spot away.

Multiply

Multiply literally multiplies the brightness value of a pixel using the pixels in the layers beneath it. The result is a darkening of all pixels unless one of the layers happens to be pure white. The darker the original layers, the more pronounced the multiplying effect.

This is a good mode for restoring color and tonal density to the lighter parts of an overexposed image. Duplicating an image into a layer set to Multiply mode will build up density.

To best illustrate this, I’ve added a fifth example where the image has been multiplied over itself (Figure 28e). The effect is a deeper saturation of all the colors as well as darkening everywhere. Note that the opacity for the layer has been reduced. If you want the effect to be stronger, you can duplicate the Multiply layer as many times you want. Of course, the image will start getting really dark and muddy at some point.
Color Burn

Color Burn intensifies the brightest colors of the layers underneath as well as darkening them. Less brilliant colors are driven to black.

If you blend a duplicate of the image on itself, the results are minimal where you have light colors and highlights. The results are much more noticeable as they get closer to the midtones.

This is a great blend mode if you are trying to intensify color without blowing out highlights.

Linear Burn

The Linear Burn mode is a more radical version of Color Burn and is more prone to plug shadows and to add detail in light areas. In certain cases this mode will intensify detail in washed out images better than either Multiply or Color Burn.
**Darker Color**

Darker Color is similar to Darken, but it considers only the composite image rather than working channel by channel. The top layer only takes precedence when it is considered as being overall darker than the bottom layer, whereas Darken mode might permit the darkening of a single channel.

For example, consider a person’s face on the top layer and a bright yellow flower beneath it on the bottom. The face is a darker object overall, but considered channel by channel, the blue channel is darker in the flower. Darken mode therefore would use only the red and green channels from the face to form the end result, keeping the blue channel from the flower. Darker Color mode would replace all three channels.

**The Lightening Modes**

**Lighten**

Like Darken, Lighten looks at the values of overlapping pixels in each channel, but instead it outputs the lightest tones. Pixels in the layer that are lighter in value than the pixels in the underlying layers will be visible. Pixels having the identical value or darker than the pixels below will have no effect. Pixels darker than the underlying pixels in the corresponding channel will be invisible.

Lighten will have no effect on a duplicate of itself. If you compare the examples here to those of Darken, you will see the lighter tones did affect the hue of the underlying layers.
Screen

Screen can be considered the opposite of Multiply. It takes the values of two layers and adds them together. The result is constrained to the maximum brightness of either layer.

Just as Multiply was an easy fix for overexposed images, Screen is an easy fix for underexposed images, provided you are careful not to blow out the lightest areas of the image.

Color Dodge

Color Dodge increases the saturation of colors while lightening them. Lighter colors are affected more than dark colors, so the result is a stronger contrast than you would get from Screen.
Linear Dodge

Linear Dodge is a more extreme version of Color Dodge and is more prone to blow out the lightest areas. But it is also capable of more exciting effects with color.

Lighter Color

Lighter Color has the same relation to Lighten that Darker Color mode does to Darken. It either replaces all channels or none. Where the top layer is found to be overall lighter, it replaces the bottom layer entirely. In Lighten mode, any channel that is lighter than the one underneath will replace it, so it’s possible for only one or two channels to change.
The Darkening Plus Lightening Modes

Overlay

Overlay is the most important of half a dozen modes that operate under the same principle but create different results. All the methods in this section of the menu create a lighter result in any channel where the corresponding channel in the top layer is lighter than 50% gray. Where the top channel is darker than 50% gray, it darkens the channel underneath it. And, significantly, where the top layer is at 50% gray exactly, it has no effect on the underlying layer.

Because 50% gray has no effect, retouchers often fill the top layer with 50% gray and then dodge and/or burn it to lighten or darken the underlying layer rather than apply the moves to the underlying layer directly. That way the effect can easily be reversed later in the process by restoring the top layer to 50% gray.

A good way to visualize how Overlay works is to create a new layer over an image, fill that new layer with exactly 50% gray (Edit > Fill > Use: 50% Gray), and set its transfer mode to Overlay. It will appear as if the new layer has disappeared. Next, fill the layer with a black-to-white horizontal linear gradient. The areas under the lighter end of the gradient will look like they’re being screened, the areas closer to the black area of the gradient will look like they’re being multiplied, and the regions near the gray midtones will have very little effect applied to them.

Overlaying an image on top of itself can be used to increase contrast and color intensity, but this can result in a pretty heavy-handed effect; keep your mouse over the Opacity slider to adjust the effect.
**Soft Light**

Like Overlay, Soft Light increases contrast but has a lesser effect on deep shadows and bright highlights. Soft Light's selective lightening and darkening is great for painting exposure changes onto an image. Painting black or white (some brush transparency helps) onto an empty Soft Light layer will simulate dodging and burning, but with the additional control over the opacity of the effect (the Layers panel's Opacity slider).

**Hard Light**

Hard Light, like Overlay, multiplies dark areas and screens light areas. These operations, however, are based on the color or tone in the Hard Light layer rather than underlying layers. Unlike Soft Light, painting black or white into a Hard Light layer will result in solid black or white. Placing a duplicate layer over its original and using the Hard Light mode will increase the image's contrast, and the result is similar to but stronger than Overlay.

The basic visual effect of Hard Light is easy to understand in a grayscale-layered document. Where a Hard Light layer has values approaching black and approaching white, it will overpower the tones beneath it. Where the Hard Light layer contains primarily mid-tone grays, its effect will be minimal; in fact, true 50% gray has no visible effect, just like in the Overlay mode.
**Vivid Light**

The Vivid Light mode dodges and burns more drastically than any of the preceding modes. The farther the overlying color is from 50% gray, or a neutral density, the stronger the contrast will be.

**Linear Light**

The Linear Light mode is similar to Vivid Light but does not protect the extreme lights and darks of the lower layer. It may add contrast to the midrange slightly more effectively than Vivid Light does.
Pin Light

Pin Light combines the effects of Lighten and Darken at the same time. Like Lighten and Darken, it does its calculations on a channel-by-channel basis. If a color is lighter than the color below it, the result will be a lightening of the color. If the color is darker, a darkening effect will result. The closer the tones are to a neutral density the less the effect will be.

Like some of the other modes, Pin Light will have no effect when applied to a duplicate over itself.

Hard Mix

The Hard Mix mode applies the Threshold filter to an image. When you blend one layer over another or a copy of itself, the result will be a posterizing effect. It does have a different result than the Posterize Adjustment layer.
The Comparison Modes

Difference

Difference looks at the values of the colors in the layer and compares them to the layers underneath. If the values are the same, the result is black. Where there is a different value, the results will vary, creating some unusual effects.

Often an original scanned image is too big for the scanner to handle in one pass. This mode is perfect for aligning different layers from scans that were produced in multiple passes.

Let’s say the image you are scanning is too large for the scanner and has to be done in two passes. Increase the Canvas Size (Image > Canvas Size) to accommodate the second scan. Drag the second scan into the image. The second scan will automatically fall into a separate layer. Put that layer in Difference mode. Using the Move Tool, reposition the layer over the original. When the area where they overlap is completely black, they are perfectly aligned.

Exclusion

At high Opacity settings, Exclusion can be used to produce effects like solarization—but lighter than the filter version. At low Opacity settings it will reduce saturation and contrast.
The Color and Contrast Modes

**Hue**

Hue is the actual color tonality of a color value. This mode will change the color while leaving the brightness and saturation untouched. It is a good mode for tinting. Hue will have no effect on black, white, or gray.

**Saturation**

Saturation is how intense or pure a color is. The saturation of the colors in an underlying layer will be replaced by the saturation of the upper layer. A lot of saturation will result in richer colors, less saturation will create pastel-like or muted colors, and a lack of saturation in a color image will result in grayscale values. Needless to say, Saturation will have no effect on black or white.

This mode is good for varying levels of saturation control, but using a Hue/Saturation adjustment layer will give you the same control (in addition to hue and brightness manipulation).
Color

Color will change the hue and saturation of the colors in the underlying layer without altering darkness. When using this mode, the brightness values, or details, of an underlying image are retained while the hue and saturation of the overlaid element is transferred to the background. Color is one of the preferred modes for tinting images. Color works stronger than Hue and results in a heavier saturation of colors.

Luminosity

Luminosity changes the brightness/detail values of underlying images without affecting the underlying layer’s hue and saturation. This is a good mode to use when you want the effect of a texture to cover an image. The lights and darks that make up the texture will be superimposed over the image.
Opacities

To the right of the Mode menu is Opacity, and right below it is Fill (Figure 50). In the Layer Style dialog box Fill is referred to as Fill Opacity. Basically, these two items do the same thing but to different recipients.

Figure 51 shows a file with a layer called Blue oval that contains just that—a blue oval. A layer below it contains some text.

In Figure 52 the layer with the blue oval has been given a few layer styles to give it some dimension.

In Figure 53 the Opacity for the Blue oval layer has been reduced to 20%. Note that you can see the text layer underneath showing through. The top layer has become partially transparent.

In Figure 54 the Opacity remains at 100%, but the Fill was lowered to 20%. This time the effect is quite different. Fill is the opacity that applies to the actual pixels that were created for the layer—the blue. The pixel values that were generated for the effects in the layer style remain at 100 percent transparency because the Opacity is still set at 100%. Only the blue pixels became 20% transparent. As you learned earlier, Opacity affects the entire layer, thus reducing the pixel values of the layer styles. Fill affects only the original pixels in the layer, not drop shadows or other layer styles.
To further illustrate this concept, Figure 55 shows a layer containing some white dots that have been given a variety of layer styles. Both the Fill and Opacity remain at 100%. In Figure 56 the Fill has been reduced to zero. The result is that the white is invisible in the layer with the exception of the whites in the highlight of the Bevel and Emboss layer style.

**Lock Boxes**

Four icons are located just below Mode at the top of the Layers panel (Figure 57). They allow you to lock portions of a layer to prevent alteration.

The first icon is Lock Transparency. With transparency locked, you can only paint within pixels that already exist in the layer. You will not be able to make any additions to the transparency area that is displayed by a checkerboard pattern. Throughout the book I refer to this many times, because this function is critical to the work I do.
**Figure 58** shows a file that has a layer containing a red circle. Using a Spatter Paintbrush and a blue color, a stroke is applied over the circle in **Figure 59**. Note that the stroke goes beyond the borders of the circle.

The stroke is undone and the transparency is locked at the top of the panel. The stroke gets reapplied. This time the stroke stays within the area of the circle and does not spill out into the area of transparency, as shown in **Figure 60**.

The second icon, Lock Image Pixels, contains a little paintbrush. It protects the existing pixels from any modification. With this icon selected, nothing can be modified in the layer, although positioning can be moved and transforms can be applied.

The third icon, Lock Position, contains a little cross. It locks the position of the elements in the layer so they can’t be moved.

The fourth icon, Lock All, contains a lock. It kind of speaks for itself; it locks everything.
The List of Layers

Now let’s look at the main body of the Layers panel (Figure 61)—the list of layers.

As you learned earlier in this document, turning the “eye” icon off for a layer makes it invisible; turning it on permits the contents to be seen. To the right of the column containing the eyes is the list of all the layers.

Groups

Layers can be kept organized by placing them in groups. Figure 61 shows a portion of the Layers panel where a number of folders can be seen. These folders are groups. You can have folders inside folders, inside folders.

At the bottom of the panel is the Create a new group icon (Figure 62). Clicking this icon creates a folder in the panel where layers can be created or existing layers can be dragged into. You can place multiple layers into a group in one step by selecting them and choosing the New Group from Layers option from the panel’s drop-down menu.

Folders can be named by double-clicking on the name of the folder in the panel. All the layers in a folder are considered a group.

A subgroup can be created in a group—that is, a folder in a folder. Basically, you can organize layers into folders much the same way you organize files on the desktop. Figure 63 shows multiple groups as well as subgroups in part of the panel for the file of the face of the Damen train.

However, too many folders can become a bit chaotic. To alleviate the clutter, groups can be colorized to help keep them and you organized. Choose Group Properties from the Layers panel drop-down menu to bring up the dialog box pictured in Figure 64. Here you can assign colors to groups. Figure 65 shows the same panel but the various groups are now colorized for easy identification.
Layer Style

In Figure 65, notice that two of the layers have a small fx symbol and an arrow at the far right. The fx represents a very cool feature of layers—the layer style. Clicking the down arrow to the right of the fx displays the list of the currently selected styles for that layer (Figure 66).

Layer styles were introduced in Photoshop version 6 and enhanced in version 7. Layer styles greatly simplified many of the techniques that were necessary before their introduction.

If you look at the Layers panel for the train in Damen (Figure 67), you'll notice that more than half the layers visible have a layer style applied. Needless to say, I use them a lot.

Layer styles are used throughout the book. Many of them, like drop shadows and glows, simulate the effects of light on objects. Others, like strokes and gradients, add effects to the object.
Separating layer styles

Looking closer at the glass on the lower right of “Lunch in Tiburon” you will see some light reflections that appear to have two different colors surrounding them. The tiny highlights visible in the close-up view in Figure 68 show outer glows that are blue on one side and yellow on the other.

In this case, two outer glows have been applied. How is this possible since you can only have one outer glow? Simple. I separated the layer style from the layer.

Figure 69 shows a circle that has been given the Outer Glow style with a yellow color. With the layer selected in the panel, select Layer > Layer Style > Create Layers (Figure 70). This function extracts all the layer styles applied to a layer and places them in individual layers for each style. On top of Figure 71 is the Layers panel containing the layer with the layer style. On the bottom is the result after the layer style has been separated from the layer.
Once the glow is in its own layer, it can be manipulated independently of the layer from which it came. Figure 72 shows the glow offset to the left of the circle. In Figure 73 a new layer style of a blue Outer Glow has been applied to the layer with the circle. Again, the style is separated and offset to the right, as shown in Figure 74.

More layer styles

I'll cover a few of the layer styles that are not mentioned in the book. The layer styles Color Overlay, Gradient Overlay, and Pattern Overlay will render what their names imply over the contents of a layer. Mode settings, colors used, and parameters entered will all have an additional effect on the contents of a layer. One solution that these particular styles provide is how to add gradients and patterns to Shape layers.

Since Shape layers use a path to mask out a shape made up of the Foreground color in a layer, adding a gradient to that shape is simply a matter of applying a Gradient layer style to the shape layer. Figure 75 shows a Shape layer. In Figure 76 a Gradient Overlay has been applied, giving the shape the gradient.

---

**Figure 72** The Outer Glow, in its own layer, has been moved to the left.

**Figure 73** A blue Outer Glow has been added.

**Figure 74** The blue Outer Glow is offset to the right.

**Figure 75** A Shape layer containing a red background masked by a path.

**Figure 76** The layer style Gradient Overlay adds a gradient to the Shape layer.
The Stroke style adds a stroke to the outer edge of the layer. This differs from a regular stroke in that being a layer style it can easily be modified. The thickness, color, and mode can be changed without having to select it or go through all the procedures for a regular stroke.

In Figure 77 you see a logo that has a stroke applied to the edge of the letterforms. Using the Stroke layer style, I’ll apply a second stroke (Figure 78).

Because the red stroke I applied to the logo is a layer style, it can easily be changed. In Figure 79 the stroke’s color and thickness are changed.

Figure 77 A logo.

Figure 78 The layer style Stroke is applied to the layer with the logo.

Figure 79 The attributes of the stroke are changed in the Layer Style window.
Masking

There are many ways of masking in layers. Layers can be used to mask other layers. Actual masks can be applied to layers. Let’s study some of these fabulous effects by starting with one I use a lot in the course of creating my paintings—the Clipping Group.

The Clipping Group

A Clipping Group is a collection of layers where the bottommost layer is used to mask the other layers in the group. It works by using the transparency area of the base layer as the basis for the mask. Any parts of the layers above the base layer that fall within the area of transparency will be hidden. Areas of those layers that fall within the area of active pixels in the base layer will be visible. Figure 80 demonstrates this concept. On the left side of the figure you see the original three layers (red, green, and blue).

In the center is a three-dimensional view showing the stacking order of the three layers. The red, being the bottommost layer, will be the mask layer. The portions of the green and blue layers that fall outside the area of the red circle will not be visible.

The right side of the figure shows the result of the Clipping Group. Note how the group is displayed in the panel. The base layer becomes underlined, and all the layers in the group become indented with a small arrow pointing toward the base layer.

Figure 80 The Clipping Group uses the transparency information of the base layer to mask the contents of the other layers that fall within that transparent area.
There are a few ways of creating Clipping Groups, but I prefer the easy keyboard shortcut. If you have a couple of layers you want to group, pass the cursor over them in the Layers panel. You’ll see the little pointing hand travel up and down. Press the Option (Alt) key and pass the cursor over the layers again. This time the cursor will change as it comes between two layers in the panel. Clicking while the cursor has changed will clip the two layers.

Each layer in the group can be altered in any way. Layer styles can be applied to individual layers, and they will only be seen through the active pixels of the base layer being used as the mask. It is important to note that any modification to the base layer will affect all the layers. For example, if the Opacity for the base layer is reduced, that amount of opacity reduction will be applied to all the layers in the group. In Figure 81 you see a file with three layers in a Clipping Group.

In Figure 82 the Opacity for the blue layer, topmost in the group, has been reduced to 50%. Notice that the green and red layers are visible though the blue shape.

In Figure 83 the Opacity settings for the green and blue layers are set to 100% but since the Opacity for the base layer (red layer) has been reduced to 50%, all the layers appear equally transparent.
Layer masks

Layer masks act directly on the layer to which they are assigned. Masks assigned to the base layer of a Clipping Group affect the other layers in the group, as you saw in the previous example.

Very much like Alpha channels, discussed in the Channels PDF file, layer masks are separate channels attached to a layer. Layer masks can be created by choosing the option from the menu (Figure 84). If you create a layer mask via the toolbar menu, you have the choice of beginning with the normal white layer mask (Reveal All), or if it’s more convenient, a black layer mask (Hide All). You can also create a layer mask by clicking the Add layer mask icon at the bottom of the Layers panel (Figure 85).

Figure 84 Layer masks can be added to a layer from the Layer menu.

Figure 85 Layer masks can be created by clicking the Add layer mask icon in the Layers panel.
Where the layer mask is black, the contents of the layer will be invisible. Where the mask is white, the contents will be 100 percent visible. The level of gray in between will determine the opacity of the contents of the layer. For example, parts of the mask that contain a 50% gray will make the layer 50% transparent in those areas.

In Figure 86 you see the layer at the bottom being processed through a mask with a gradient above it. At the top you see the result of the mask on the visibility of the layer.

In Figure 87 you see a document that has a layer with flowers sitting over the background image of a veranda on a ship. Applying a gradient to a layer mask for the layer of the flowers makes the flowers disappear where the mask is black (Figure 88). The flowers are fully visible where the mask is white. The level of gray in the gradient makes the flowers gradually fade to invisibility.